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The original version of this manual was written in English language.

CONFIDENTIALITY STATEMENT

This document is the confidential property of Siemens AG Medical
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No part of it maybe transmitted, reproduced, published, or used by
other persons without the permission of Siemens AG Medical 
Solutions.



MAMMOMAT Inspiration
SPB7-330.640.01.01.02

Do you have any notes on this 
operator manual? 

Your opinion matters a lot to us! 0

We make every effort to continuously improve our product documentation. 

Therefore, we would like to offer you the opportunity of giving us your direct 

feedback concerning your requests, suggestions and criticism with respect to 

this operator manual. 

o For feedback by fax, please use the following fax number:

+49 9131/84-2378 

o If you prefer notification by mail, please send this to:

sp_ga.med@siemens.com

In this case we request you to use as reference the complete print number in 

the footer of this page.

Thank you very much for supporting us in our efforts to improve our products.

My notes

Optional information

Name

Hospital

City/country

E-mail

Telephone/fax

Number of fax pages
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List of Common Abbreviations

AEC Automatic Exposure Control

AWS Acquisition Work station

FD Flat Detector

kV Kilovolt

mAs milliAmperesecond

MEE Mammography Equipment Evaluation

Mo/Mo Molybdenum/Molybdenum

Mo/Rh Molybdenum/Rhodium

MP Medical Physicist

PMMA Poly Methyl Methacrylate

ROI Region of Interest

SMPTE Society of Motion Picture and Television Engineers

SNR Signal-to-Noise-Ratio

T Technologist

W/Rh Tungsten/Rhodium
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Introduction

Mammography Equipment Evaluation (MEE) - Medical 
Physicist (MP)

The MEE tests of the MAMMOMAT Inspiration should be performed whenever a 

new MAMMOMAT Inspiration system has been installed and whenever changes that 

might affect performance have been made to an existing system. For example, the 

MEE tests shall be performed if the system has been disassembled and reassembled 

or if major components have been changed or repaired.

The MEE tests of the MAMMOMAT Inspiration involve performance of all QC 

procedures in this Quality Control Manual, ensuring that a basic minimum image 

quality criteria is met before the system is used on patients. For each part of the MEE 

tests, action levels that must be met are specified. Furthermore, the values obtained 

during the MEE tests are to be used as baseline values, and then referred to during 

future tests to determine if equipment performance is stable or changing.

Annually - Medical Physicist (MP)

These tests may be performed by the MP. The tests include comparisons to values 

measured during the MEE tests to ensure that performance has not degraded.

Monthly - Technologist (T)

These tests shall be done on a monthly basis. They shall be done on the first working-

day of the month before patients are examined with the MAMMOMAT Inspiration 

system.

When Needed - Technologist (T)

These tests shall be done whenever there is suspicion of artifacts or incorrect settings 

to determine if patients can be examined.
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Recommended Frequency of QC Tests

The following table describes when the different tests must be performed and by 

whom.

Table 1 Frequency of Tests

Test MEE Annually Monthly When 
needed

1. AEC Test MP MP

2. Artifact Detection MP T

3. Detector Uniformity MP T

4. Detector Linearity MP MP

5. Phantom Imaging Quality MP T

6. Spatial Resolution (optional) T

7. Mechanical Tests MP MP

8. Acquisition Workstation Monitor Check MP MP

9. Printer Check (optional) MP MP
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For the qualification of the printer please follow the printer manufacturer’s 

recommendations.

Important Notes

Before performing any quality control test, be sure to be familiar with the operating 

instructions described in the MAMMOMAT Inspiration Operator Manual.

The enclosed test form tables can be used to document test parameters used and 

results obtained during each test.

Recommended Corrective Action

Whenever there is a result from a test described in this manual that fails to reach the 

action level stated, the problem must be detected and corrected before further 

examinations are performed with the system. The result shall be reported to a service 

engineer and proper corrective action shall be taken to address the problem.

If a result meets the action level, but a clear degradation is seen compared to the 

result obtained during the latest test, the system may continue to be used, but the 

degradation shall be reported to a service engineer, and it is recommended that 

corrective action be taken within 30 days. 

More details are given in association with each test.

Required Documents

• MAMMOMAT Inspiration Operator Manual

• Quality Control Manual of used viewing station (optional - for systems that 

use softcopy review station)
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Required Equipment

The measurement devices listed below must always display a valid calibration stamp 

to ensure compliance with the described measurement and calibration intervals.

• Lint-free, non-woven cotton or gauze (100% cotton)

• Water or lukewarm diluted aqueous solution of household dishwashing liquid

• Compression plate 24 x 30 cm2

• Radiation shielding plate in object table size (e.g. 2 mm steel or lead plate)

• PMMA plates of 10 x 10 cm2 and 20 mm, 30 mm, 40 mm, 50 mm, 60 mm, 

70 mm thicknesses

• Collimator mountable PMMA phantom (40 mm thick) 

• Dose meter for air kerma measurement usable for target/filter combinations 

Mo/Mo, Mo/Rh, W/Rh

• ACR (RMI 156) phantom

• Bar pattern phantom applicable for mammography

• Compressible phantom

• Stop watch

• Calibrated densitometer (option) 
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Prerequisites

Objective

To determine whether the detector is damaged or has dust on it and is calibrated.

Required Equipment

a) Lint-free, non-woven cotton or gauze (100% cotton)

b) Water or lukewarm diluted aqueous solution of household dishwashing liquid

Procedure

1. Wipe the detector surface with a wet lint-free, non-woven cotton cloth or cotton 

(100%) pad. For moistening, use water or lukewarm diluted aqeous solution of 

household dishwashing liquid.

NOTE!NOTE!

Do not spray the unit! The cleaning fluid must under no circumstances 
penetrate into the unit. 

2. Calibrate the detector according to the chapter Calibrating the detector in the  

MAMMOMAT Inspiration Operator Manual.

CAUTION!

Improper operation can lead to reduced image quality. 

Let the MAMMOMAT Inspiration warm up for at least 30 minutes to 
ensure optimum results when performing an image quality test or a 
calibration.

CAUTION!

For startup and login, see MAMMOMAT Inspiration Operator Manual.

CAUTION!

Before starting the quality control tests the detector calibration shall be 
performed to ensure that the tests are based on correct detector 
settings, see MAMMOMAT Inspiration Operator Manual.

Performance Criteria and Corrective Action

No visual damage to the detector should be observable.

No artifacts should be visible.
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Calculations

1 Statistical calculations

For all numerical calculations necessary in this quality control manual the testing 

person should use the formulae indicated in the following text together with a pocket 

calculator or appropriate software for numerical evaluations.

Preliminaries:

From the knowledge of any finite set of measurement values x1, x2, ..., xN the 

following fundamental statistical quantities can be established.

1.1 Global average of values

xN = each value (e.g. x1 = value of pixel 1, x2 = value of pixel 2) 

N = number of measurement values (e.g. 6, for 6 PMMA thicknesses)

xav = global average of values

1.2 Standard deviation

σx = standard deviation

With the average value xav calculated according to Global average of values.

1.3 Coefficient of variation

cvar, x= coefficient of variation

With the average value xav and the standard deviation σx calculated according to 

Global average of values and Standard deviation respectively.

xav

x
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x
2

x
3

... xN+ + + +

N
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1.4 Relative deviation from corresponding average

Each sample xn from the set of measurements x1, x2, ..., xN possesses its own 

relative deviation ∆xrel, n from the average xav according to the following definition:

n = 1, 2, ..., N

∆xrel, N= relative deviation for each value

Average value xav calculated according to Global average of values.

For maximum relative deviation select highest value of all calculated relative 

deviations.

2 Linear correlation coefficient and offset

Calculate for quantity x = pixel value and quantity K= input air kerma value.

Assume that in total N (generally different) sample values K1, K2, ..., KN for the input 

air kerma have been selected and the mean pixel values x1, x2, ..., xN in the 

corresponding X-ray images have been recorded.

a) Calculate global average of all pixel values (xav) and global average of all input air 

kerma values (Kav)

b) Calculate average of pixel and input air kerma values (x 
. K)av and K2

∆xrel ,n

xn xav–

xav
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c) Calculate standard deviation of all pixel values (σx) and standard deviation of all 

input air kerma values σK.

d) Calculate linear correlation coefficient R

e) The offset (zero input signal) doff of the X-ray detector is derived from

3 SNR - Signal-to-noise ratio

Provided that the detector offset doff is known, for each individual X-ray image (or a 

region-of-interest located therein) the pixel signal-to-noise ratio SNR can be calculated 

from the pixel value xN of each image and the corresponding standard deviation σx: 

R
x K⋅( )av xav Kav⋅–

σx σK⋅
------------------------------------------------=

doff

K( )
2

av xav⋅ Kav K x⋅( )av⋅( )–

σK

2
-------------------------------------------------------------------------=

SNR
xN doff–

σx

------------------=
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Test 1: AEC Test

Objective

To test the AEC security cut-off

To measure AEC stability for different object thicknesses 

Required Equipment

a) Shielding plate in object table size, e.g. 2 mm steel or lead plate

b) PMMA plates of 10 x 10 cm² and 20 mm, 30 mm, 40 mm, 50 mm, 60 mm, 

70 mm thicknesses

c) Compression plate 24 x 30 cm2

Procedure

1. Create a new patient record in the local database. 

Fill in: Last Name: Test_One

First Name: AEC

Patient ID: day+time when the test is performed

(example: 200707071030)

DOB: 05 05 1955

Gender: Other

2. Choose procedure QC-raw.

AEC security (step 3 - 10)

3. Select exposure technique AEC

28 kV

target/filter combination mostly used

grid in

auto decompression off

OPCOMP off

AEC segmentation on

low dose mode off

4. Place shielding plate on object table.

5. Mount compression plate and perform compression.

6. Perform an exposure.

7. Check that the radiation signal lights up very shortly and exposure is interrupted, 

tube load is below 5 mAs.

8. Check that a warning is shown. 

9. Note result in Test form Test 1.

10. Deactivate examination, remove shielding plate.
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AEC stability (step 11 - 23)

11. Select exposure technique Opdose

grid in

auto decompression on

OPCOMP on

AEC segmentation on

low dose mode off

12. Position 20 mm PMMA plate on object table according to Figure 1.

Figure 1   Placing the PMMA plate

13. Perform compression until OPCOMP is reached.

14. Perform an exposure with the Opdose program according to PMMA thickness, 

note exposure data.

15. Select Tools > AEC region to show the AEC region of the acquired image.

16. Check that the AEC region of the acquired image remains inside the edges of the 

PMMA plate.

Detector

PMMA plate

Chest wall side
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17. Define a ROI within the AEC region according to Figure 2.

Figure 2   ROI within the AEC region

18. Note the displayed mean pixel value in Test form Test 1.

19. Repeat steps 11 to 18 for PMMA thicknesses 30 mm, 40 mm, 50 mm, 60 mm, 

and 70 mm

20. Close examination.

21. Calculate global average of all mean pixel values over all PMMA thicknesses

- derive standard deviation of mean pixel values from global average over all 

PMMA thicknesses

- derive resulting coefficient of variation (see Calculations, page 12)

- Note results in Test form Test 1

22. For each PMMA thickness calculate the relative deviation between the detected 

mean pixel value and the global average of all mean pixel values and note result 

in Test form Test 1.

23. Identify and note the maximum relative deviation out of the results from step 22.

AEC region

ROI
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Performance Criteria and Corrective Action

The AEC security cut-off mechanism shall work properly in such a way that in cases 

where no radiation reaches the detector no tube load beyond 5 mAs can be delivered.

The AEC segmentation should be able to select an AEC region that:

- completely remains inside the shadow of the PMMA plates, and

- whose borders are close to the ones of the PMMA.

The coefficient of variation for the mean pixel values should not exceed 5 % when 

going through all PMMA thicknesses.

The maximum relative deviation for the mean pixel values should not exceed 10 % 

when going through all PMMA thicknesses.
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Test form Test 1

Passed Failed

AEC security cut-off l l

Warning shown l l

Thick-
ness of 
PMMA 
(mm)

Voltage
(kV)

Tube load
(mAs)

AEC region inside 
PMMA plates

Mean 
pixel 
value

Relative 
deviation of 
mean pixel 
value from 

global average

Passed Failed

20 l l

30 l l

40 l l

50 l l

60 l l

70 l l

Performance
Criteria

Passed Failed

Global average of mean pixel 
values over all PMMA 
thicknesses

Standard deviation of mean 
pixel values from global aver-
age over all PMMA thick-
nesses 

Resulting coefficient of 
variation

< ± 5 % l l

Maximum relative 
deviation 

< ± 10 % l l
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Test 2: Artifact Detection

Objective

To determine if the detector is dusty, damaged or shows artifacts of any kind.

Required Equipment

a) Collimator mountable PMMA phantom

b) Compression plate 24 x 30 cm2

Procedure

1. Create a new patient record in the local database. 

Fill in: Last Name: Test_Two

First Name: Artifact Detection

Patient ID: day+time when the test is performed

(example: 200707071030)

DOB: 05 05 1955

Gender: Other

2. Select procedure QC-raw.

3. Select exposure technique MANUAL

28 kV

90 mAs

target/filter Mo/Mo

grid in

auto decompression off

OPCOMP off

Change all projection views to L-CC

4. Mount PMMA phantom close to collimator.

5. Mount compression plate and perform compression.

6. Perform exposure.

7. Look at the image for clinically relevant artifacts, e.g. defective pixels, clusters of 

defective pixels or defective lines/columns. Use magnification tool, select 

acquisition size, adapt windowing values. If problems regarding viewing 

conditions appear send image to viewing station for further evaluation.

8. Repeat step 3 to 7 for target/filter combinations Mo/Rh and W/Rh.

9. If artifacts are visible make sure that the detector is free of dust, perform a new 

calibration, and repeat test.
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10. If artifacts are still visible on any image after step 9 call Siemens customer 

service.

11. Note result in Test form Test 2.

12. Close examination.

Performance Criteria and Corrective Action

No clinically relevant artifacts shall be visible on image.
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Test form Test 2

Target/filter 
combination 

Mo/Mo

Target/filter 
combination 

Mo/Rh

Target/filter 
combination 

W/Rh

Passed Failed Passed Failed Passed Failed

No clinically 
relevant 
artifacts 
detected

l l l l l l
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Test 3: Detector Uniformity

Objective

To measure the uniformity of the detector response over its entire surface

Required Equipment

a) Collimator mountable PMMA phantom

b) Compression plate 24 x 30 cm2

Procedure

1. Create a new patient record in the local database. 

Fill in: Last Name: Test_Three

First Name: Detector Uniformity

Patient ID: day+time when the test is performed

(example: 200707071030)

DOB: 05 05 1955

Gender: Other

2. Select procedure QC-raw.

3. Mount PMMA phantom close to collimator.

4. Mount compression plate and perform compression.

5. Select exposure technique AEC

28 kV

target/filter combination Mo/Mo

grid in

auto decompression off

OPCOMP off

AEC segmentation off

low dose mode off

Change all projection views to L-CC

6. Perform exposure.
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7. Define an ROI with a size of approximately 20 x 20 mm2 in arbitrary position 

inside the image. 

8. Move this ROI subsequently to each of the five positions indicated in Figure 3. If 

helpful switch off image text, menu View > No Text.

Figure 3   ROIs on the detector

9. For each of these five ROI positions note the corresponding mean pixel value in 

Test form Test 3.

10. Calculate global average of mean pixel values over all five ROIs.

11. For each ROI calculate relative deviation from global average (see Relative 

deviation from corresponding average, page 13).

12. Identify and note the maximum relative deviation out of the results from step 11.

13. Repeat steps 6 to 12 for target/filter combinations Mo/Rh and W/Rh.

14. Close examination.

Performance Criteria and Corrective Action

The maximum relative deviation from global average should not exceed 7 %.

2

5

3

1

4

2 cm

2 cm2 cm

2 cm
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Test form Test 3

Target/filter combination Mo/Mo

Target/filter combination Mo/Rh

Mean pixel value Relative deviation 
from global average

ROI 1

ROI 2

ROI 3

ROI 4

ROI 5

Global average of mean pixel 
values

Performance
Criterion

Passed Failed

Maximum relative 
deviation

≤ 7 % l l

Mean pixel value Relative deviation 
from global average

ROI 1

ROI 2

ROI 3

ROI 4

ROI 5

Global average of mean pixel 
values

Performance
Criterion

Passed Failed

Maximum relative 
deviation

≤ 7 % l l
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Target/filter combination W/Rh

Mean pixel value Relative deviation 
from global average

ROI 1

ROI 2

ROI 3

ROI 4

ROI 5

Global average of mean pixel 
values

Performance
Criterion

Passed Failed

Maximum relative 
deviation

≤ 7 % l l
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Test 4: Detector Linearity

Objective

To measure the linearity of the detector response against input air kerma for all target/

filter combinations.

To measure the noise of the system

Required Equipment

a) Collimator mountable PMMA phantom

b) Dose meter for air kerma measurement usable for target/filter combinations 

Mo/Mo, Mo/Rh, W/Rh

c) Compression plate 24 x 30 cm2

Procedure

1. Create a new patient record in the local database. 

Fill in: Last Name: Test_Four

First Name: Detector Linearity

Patient ID: day+time when the test is performed

(example: 200707071030)

DOB: 05 05 1955

Gender: Other

2. Select procedure QC-raw.

3. Select exposure technique Manual,

28 kV

5 mAs

target/filter combination Mo/Mo

grid in

auto decompression off

OPCOMP off

AEC segmentation off

low dose mode off

4. Mount PMMA phantom close to collimator.
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5. Position dose meter on object table according to Figure 4.

Figure 4   Positioning the dose meter

6. Mount compression plate and perform compression.

7. Perform exposure.

8. Note measured input air kerma in Test form Test 4.

9. Define a ROI according to Figure 5, making sure that there is a distance of at least 

2 cm between ROI and dose meter.

Detector

Dose meter

Chest wall side

Center
2 cm

7 cm



Test 4: Detector Linearity

MAMMOMAT Inspiration 29

SPB7-330.640.01.01.02

Figure 5   ROI Positioning

10. Note mean pixel value and standard deviation (SD) inside ROI.

11. Repeat steps 7 to 10 for all tube load values in Test form Test 4.

12. Calculate the linear correlation coefficient between input air kerma and resulting 

mean pixel value (see Linear correlation coefficient and offset, page 13).

13. Calculate detector offset for mean pixel value versus input air kerma (see Linear 

correlation coefficient and offset, page 13).

14. For each of the images generated in steps 7 to 11 calculate the SNR in the 

corresponding evaluation ROIs by taking into account the result for the detector 

offset from previous step (step 13); note SNR into corresponding column in Test 

form Test 4.

15. Repeat steps 7 to 14 for target/filter combinations Mo/Rh and W/Rh. Note 

corresponding results in Test form Test 4.

16. Close examination.

Performance Criteria and Corrective Action

The linear correlation coefficient should be greater than 0.99.

The Offset should be between 45 and 55.

The SNR should exceed indicated lower thresholds.

2 cm
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Test form Test 4

Target/filter combination: Mo/Mo, tube voltage 28 kV

Exposure
No.

Tube load
(mAs)

Air kerma
(mGy)

Mean pixel 
value

SNR

1 5

2 10

3 20

4 40

5 63

6 80

7 110

8 180

9 280

10 360

Performance
Criteria

Passed Failed

Detector offset ________
40 - 60 l l

Linear correlation coefficient ________
0.99 l l
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Target/filter combination: Mo/Rh, tube voltage 28 kV

Exposure
No.

Tube load
(mAs)

Air kerma
(mGy)

Mean pixel 
value

SNR

1 5

2 10

3 20

4 40

5 63

6 80

7 110

8 180

9 280

10 360

Performance
Criteria

Passed Failed

Detector offset ________
40 - 60 l l

Linear correlation coefficient ________
0.99 l l
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Target/filter combination: W/Rh, tube voltage 28 kV

Exposure
No.

Tube load
(mAs)

Air kerma
(mGy)

Mean pixel 
value

SNR

1 5

2 10

3 20

4 40

5 63

6 80

7 110

8 180

9 280

10 360

Performance
Criteria

Passed Failed

Detector offset ________
40 - 60 l l

Linear correlation coefficient ________
0.99 l l
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Test 5: Phantom Imaging Quality

Objective

To ensure that adequate phantom imaging quality is achieved

Required Equipment

a) ACR (RMI 156) phantom

b) Compression plate 24 x 30 cm2

Procedure

1. Create a new patient record in the local database. 

Fill in: Last Name: Test_Five

First Name: Phantom Imaging Quality

Patient ID: day+time when the test is performed

(example: 200707071030)

DOB: 05 05 1955

Gender: Other

2. Select procedure QC-raw.

3. Select exposure technique AEC

28 kV

target/filter combination Mo/Mo

grid in

auto decompression off

OPCOMP off

AEC segmentation on

low dose mode off

Change all projection views to L-CC
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4. Position phantom on object table according to Figure 6.

Figure 6   Position of Phantom

5. Mount compression plate and perform compression.

6. Perform an exposure.

7. Examine the image. For evaluation use magnification, zooming or gray scale 

inversion, adapt windowing values, if helpful. If the viewing conditions are 

considered to be inferior while looking at the image on AWS, send image to 

viewing station for additional examination of the achieved image.

Detector

ACR (RMI 156) phantom

Chest wall side
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8. Determine how many fibers, specks and masses can be identified. 

a) Select object class (mass, speck group, fiber), see Figure 7.

b) For the selected object class start evaluation at the easiest visible sample.

c) Count number of visible samples of one class. 

• A fiber is regarded as visible if it is found at correct orientation and 

location and at least half of its length is recognized

• A speck group is regarded as visible if it is found at correct 

orientation and location and at least four of its specks are 

recognized.

• A mass is regarded as visible if it is found at correct location and its 

circular appearance is recognized.

d) Note result in Test form Test 5.

5. Repeat steps 6 to 8 for target/filter combinations Mo/Rh and W/Rh.

6. Close examination.

Performance Criteria and Corrective Action

Figure 7   ACR (RMI 156) phantom

Number of objects that shall be detected:

Fibers ≥ 5

Specks ≥ 4

Masses ≥ 4
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Test form Test 5

Target/filter combination Mo/Mo

Target/filter combination Mo/Rh

Target/filter combination W/Rh

Tube load: ____________ mAs
Performance

Criteria
Passed Failed

Fibers ≥ 5 l l

Specks ≥ 4 l l

Masses ≥ 4 l l

Tube load: ____________ mAs
Performance

Criteria
Passed Failed

Fibers ≥ 5 l l

Specks ≥ 4 l l

Masses ≥ 4 l l

Tube load: ____________ mAs
Performance

Criteria
Passed Failed

Fibers ≥ 5 l l

Specks ≥ 4 l l

Masses ≥ 4 l l
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Test 6: Spatial Resolution (optional)

Objective

To detect assumed spatial resolution problems in different parts of the detector

Required Equipment

a) Bar pattern phantom (containing line groups with spatial frequencies of 5 lp/mm, 

6 lp/mm, 7 lp/mm, 8 lp/mm) applicable for mammography 

b) Collimator mountable PMMA phantom

c) Compression plate 24 x 30 cm2

Procedure

1. Create a new patient record in the local database. 

Fill in: Last Name: Test_Six

First Name: Spatial Resolution

Patient ID: day+time when the test is performed

(example: 200707071030)

DOB: 05 05 1955

Gender: Other

2. Select procedure QC-raw.

3. Select:

exposure technique MANUAL 

28 kV

90 mAs

target/filter combination clinically used

grid in

auto decompression off

OPCOMP off

4. Mount PMMA phantom close to collimator.

5. Move bar pattern phantom on object table to a position where a problem with the 

spatial resolution of the detector is assumed.

6. Mount compression plate and perform compression.

7. Perform exposure.
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8. Examine the image. For evaluation use magnification, zooming or full resolution, 

adapt windowing values, if helpful. If viewing conditions are considered to be 

inferior while looking at the image on AWS, send image to viewing station for 

additional examination of the achieved image.

9. Determine the highest visible spatial frequency where bars and adjacent spaces 

can be clearly distinguished.

10. If problems with spatial resolution are assumed in further detector parts, move 

phantom to the suspicious regions and repeat evaluation.

11. Note results in Figure 8.

12. Close examination.

Performance Criteria and Corrective Action

The maximum detectable spatial frequency shall be 7 lp/mm.
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Test form Test 6

Mark where the required spatial frequency is not reached.

Figure 8   Indication of inferior spatial resolution

Detector

Chest wall side
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Test 7: Mechanical Tests

Objective

To ensure the mechanical integrity of the system

Required Equipment

a) Compressible phantom

b) ACR (RMI 156) phantom

c) Stop watch

d) Compression plate 24 x 30 cm2

Procedure

1. Check that the control panel lights up to show that the power is switched on.

2. Turn the swivel-arm system to 180° (tube head is straight upside down). Lower 

the system as close to the floor as possible. Check that system stops above the 

floor. Raise and turn the swivel-arm system back.

3. Check the motorized movements for smooth running and normal function. 

4. Check that all foot switches operate correctly.

5. Check that the height adjustment and rotation of the swivel-arm system are 

blocked, when the displayed compression force is ≥ 30 N.

6. Check the emergency stop button for correct function. Note that with the button 

depressed, all motorized movements shall be blocked, and x-ray release is not 

possible. Release emergency stop button, Mammo unit will be reset and 

examination can be continued. Confirm message on AWS.

7. Check that object table surface and all compression plates show no sharp edges 

or cracks which could injure the patient.

8. Check that the edges of the radiation shield are clearly defined so that the user is 

aware of the outline.

9. Check that the manual compression/decompression functions properly.

10. If automatic decompression is set up the compression plate should release 

compression after an exposure automatically. The deactivation of automatic 

release should also work correctly.

11. Check that the decompression button on the control box works correctly.

12. Check that the emergency decompression button works correctly.
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13. Compression force: 

• Position compressible phantom on object table 

• Mount compression plate

• Compress phantom until applied compression force reaches 100 N

• Wait approximately one minute

• After one minute the compression force must not differ more than 10 N 

from the applied value.

• Remove compressible phantom

• Position ACR (RMI 156) phantom on object table

• Compress with 70 N

• Select Opdose mode and perform exposure

• Read out the indicated thickness from image. Check that displayed 

thickness is between 39 mm and 45 mm.

Performance Criteria and Corrective Action

To ensure the mechanical integrity all steps should be passed.
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Test form Test 7

Test no.: Performance
Criteria

Passed Failed

1. Control panel lights --- l l
2. System stops above floor --- l l
3. Check motorized movements --- l l
4. Foot switches --- l l
5. Movements blocked --- l l
6. Emergency stop button --- l l
7. No sharp edges or cracks on 

object table surface and 
compression plates

--- l l

8. Radiation shield --- l l
9. Manual compression --- l l
10. Auto decompression --- l l
11. Decompression button on 

control box
--- l l

12. Emergency decompression --- l l

13. Measured 
Thickness: ________ mm

39 mm - 45 mm l l
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Test 8: Acquisition Workstation Monitor Check

Objective

To assess the quality of the acquisition workstation monitor.

Required Equipment

a) SMPTE test pattern (provided in syngo)

Procedure

1. Clean the monitor

a) The monitor surface should be cleaned with a soft tissue material, such as 

cotton or lens cleaning paper.

b) If necessary, stubborn stains can be removed by moistening part of a cloth 

with water to enhance its cleaning power.

3. Select the Viewing task card.

4. Open the Patient Browser, select Service images, technical images.

5. Open the SMPTE in the Viewing task card. Make sure that the SMPTE covers 

the entire viewing area, e.g. the window should not be divided in four viewing 

areas.

Check that the window center is set to 2048. Check that the image is displayed 

in acquisition size under Image > Acquisition Size.

6. The gray scale is shown as a series of squares in the center of the SMPTE image, 

ranging from black (0%) to white (100%) in a rectangle. The 0% and 100% 

squares each contain smaller squares within them that represent a signal level of 

5% and 95% respectively (see Figure 9). You should be able to differentiate the 

inner square from the corresponding outer square. The 5% square is normally 

quite difficult to differentiate. If the viewing conditions are considered to be 

inferior, perform this test again with dimmed room light.

Figure 9   Location of 5 % and 95 % squares
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7. Visually check the monitor’s performance by looking for streaking, fluttering and 

shadows.

8. The spatial resolution and aliasing of the monitor are considered to be within 

acceptable limits if the high contrast bar patterns in the test image can be seen 

as patterns of white and black pairs. To use the pattern, inspect the 6 squares 

filled with varying widths of alternating black/white horizontal and vertical lines in 

each corner (see Figure 10) of the image as well as in the very center. You should 

be able to differentiate all the lines, from wide to narrow (6 pixels, 4 pixels, and 

2 pixels) both horizontally and vertically.

Figure 10   Location of bar patterns

9. Option 3MP Monitor.

• If a 3MP Monitor is available open test images from service, 

(Option > Service > Local Service) logon without service key. 

Select Acquisition System > Quality Test, 
-> Display -> Start -> Testimages, 

Select AWS Testimages.

• Perform steps 6 - 8.

• Move image over the entire monitor.

• Close service menu.

10. Close examination.
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Performance Criteria and Corrective Action

• The 5% and 95% squares shall be visible. (The preset values for brightness 

and contrast on the monitor may not be adequate to fulfill this requirement. 

Adjust brightness and contrast according to For the qualification of the 

printer please follow the printer manufacturer’s recommendations. and 

repeat Test 8: Acquisition Workstation Monitor Check.

• All different bar patterns in the four corners and in the center in the image 

(see of the Figure 10) shall be visible.

If any level is found to be beyond any action level stated, the source of the 
problem must be identified and the problem corrected by a Siemens customer 
service engineer and successfully retested by the MP before further 
examinations are performed using the system.
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Test form Test 8

Gray Scale Contrast: Yes No

5% square is visible inside 0% square l l

Performance criteria: Yes

95% square is visible inside 100% square l l

Performance criteria: Yes

Spatial resolution: Yes No

All lines in all bar patterns can be 
differentiated

l l

Performance criteria: Yes

Visual Inspection:

Yes No

Streaking l l

Performance criteria: No

Fluttering l l

Performance criteria: No

Shadows l l

Performance criteria: No
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Test 9: Printer Check (optional)
This test is only required if a laser camera is used.

Objective

To assess the quality of the laser camera.

Required Equipment

a) Calibrated densitometer

Procedure

1. Mark the service patient in the Patient Browser.

2. Choose SMPTE image from service image patient and open it in the Viewing 

task card.

3. Send the image to a printer.

4. The printer shall be configured for Min Density to 20 and Max Density to 350.

5. Evaluate the printed SMPTE image by measuring the eleven density values from 

0 to 100% with the densitometer and note the measured values in Test form Test 

9.

Performance Criteria and Corrective Action

The values for the different optical densities must be within the action limits as stated 

in table on Test form Test 9. 

If any level is found to be beyond any action level stated, the source of the 
problem must be identified and the problem corrected by a Siemens customer 
service engineer and successfully retested by the MP before further 
examinations are performed using the system.

For the qualification of the printer please follow the printer manufacturer’s 
recommendations.
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Test form Test 9

* LUT = Look-Up-Table

Customer values for Min and Max Density

Min Density

Max Density

Step Corr16b-bspline (LUT) Linear LUT*

Ref. 
LUT

 Maximum 
density

Minimum 
density

Ref. 
Density

Maximum 
density

Minimum 
density

1 0.20 0.23 0.17 0.20 0.23 0.17

2 0.34 0.38 0.30 0.52 0.56 0.49

3 0.47 0.51 0.43 0.86 0.90 0.82

4 0.64 0.69 0.59 1.18 1.23 1.13

5 0.81 0.87 0.75 1.52 1.58 1.46

6 1.05 1.12 0.99 1.84 1.91 1.78

7 1.31 1.38 1.24 2.18 2.25 2.11

8 1.66 1.74 1.58 2.52 2.60 2.44

9 2.10 2.19 2.01 2.85 2.94 2.77

10 2.68 2.77 2.59 3.18 3.27 3.08

11 3.50 3.60 3.40 3.50 3.60 3.40

Step MG1_5bCorr-bspline (LUT)

Ref. 
LUT

 Maximum
density

 Minimum
density

1 0.20 0.23 0.17

2 0.44 0.48 0.40

3 0.68 0.72 0.64

4 0.94 0.99 0.89

5 1.18 1.24 1.12

6 1.45 1.52 1.39

7 1.73 1.80 1.66

8 2.01 2.09 1.93

9 2.32 2.41 2.23

10 2.73 2.82 2.64

11 3.50 3.60 3.40
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* LUT = Look-Up-Table

Step Corr16b-bspline (LUT)

Ref. 
LUT*

Recommendation 
Maximum 

density

 Recommendation 
Minimum 
density

Required 
Maximum 

density

 Required
Minimum 
density

1 0.20 0.23 0.17 0.30 0.10

2 0.34 0.38 0.30 0.44 0.24

3 0.47 0.51 0.43 0.57 037

4 0.64 0.69 0.59 0.74 0.54

5 0.81 0.87 0.75 0.91 0.71

6 1.05 1.12 0.99 1.15 0.95

7 1.31 1.38 1.24 1.41 1.21

8 1.66 1.74 1.58 1.76 1.56

9 2.10 2.19 2.01 2.20 2.00

10 2.68 2.77 2.59 2.78 2.58

11 3.50 3.60 3.40 3.60 3.40

Step MG1_5bCorr-bspline (LUT)

Ref. LUT  Recommenda-
tion Maximum 

density

Recommendation 
Minimum 
density

 Required 
Maximum

density

 Required 
Minimum
density

1 0.20 0.23 0.17 0.30 0.10

2 0.44 0.48 0.40 0.54 0.34

3 0.68 0.72 0.64 0.68 0.58

4 0.94 0.99 0.89 1.04 0.84

5 1.18 1.24 1.12 1.28 1.08

6 1.45 1.52 1.39 1.55 1.35

7 1.73 1.80 1.66 1.83 1.53

8 2.01 2.09 1.93 2.11 1.91

9 2.32 2.41 2.23 2.42 2.22

10 2.73 2.82 2.64 2.83 2.63

11 3.50 3.60 3.40 3.60 3.40
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If your values do not meet the values specified above, then please refer to the printer 

manufacturer's quality control procedure. You can create your own baseline with the 

measured values that result from the initial installation of the printer that was installed 

per the manufacturer's QC procedure.

* OD = Optical Density

QC manual required by printer manufacturer was followed: 

SMPTE [%] Step Measured 
OD*

Passed Failed

100 1 l l
90 2 l l
80 3 l l
70 4 l l
60 5 l l
50 6 l l
40 7 l l
30 8 l l
20 9 l l
10 10 l l
0 11 l l

Compliance Yes No

Date _______________ l l

Date _______________ l l

Date _______________ l l
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